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Preface
Preface

Thank you for purchasing your Topcon receiver, survey product or 
accessory (the “Product”). The materials available in this manual (the 
“Manual”) have been prepared by Topcon Positioning Systems, Inc. 
(“TPS”) for owners of Topcon products. This Manual is designed to 
assist owners with the use of software (the “Software”) to be used 
with the Product and its use is subject to these terms and conditions 
(the “Terms and Conditions”). 

Terms and Conditions
USE This product is designed to be used by a professional. The user 
should have a good knowledge of the safe use of the product and 
implement the types of safety procedures recommended by the local 
government protection agency for both private use and commercial 
job sites.

COPYRIGHT All information contained in this Manual is the 
intellectual property of, and copyrighted material of TPS. All rights 
are reserved. You may not use, access, copy, store, display, create 
derivative works of, sell, modify, publish, distribute, or allow any 
third party access to, any graphics, content, information or data in this 
Manual without TPS’ express written consent and may only use such 
information for the care and operation of your receiver. The 
information and data in this Manual are a valuable asset of TPS and 
are developed by the expenditure of considerable work, time and 
money, and are the result of original selection, coordination and 
arrangement by TPS.

NOTICE Please read these Terms and Conditions carefully.
P/N 7010-0684 ix
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TRADEMARKS Topcon®, HiPer®, 3D-Office™, Pocket-3D™, and 
Topcon Positioning Systems™ are trademarks of TPS. Microsoft®, 
Windows®, and ActiveSync® are registered trademarks of Microsoft 
Corporation. Bluetooth® is a trademark owned by Bluetooth SIG, 
Inc. and is used by Topcon Positioning Systems, Inc. under license. 
AutoCAD® is a registered trademark of Autodesk, Inc. Other product 
and company names mentioned herein may be trademarks of their 
respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY 
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD 
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE 
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER 
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY 
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT 
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR 
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE 
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL 
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES 
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS 
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR 
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION 
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR 
COSTS INCURRED IN CONNECTION WITH OBTAINING 
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY 
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY 
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR 
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY 
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER. 

LICENSE AGREEMENT Use of any computer programs or software 
supplied by TPS or downloaded from a TPS website (the “Software”) 
in connection with the receiver constitutes acceptance of these Terms 
and Conditions in this Manual and an agreement to abide by these 
Terms and Conditions. The user is granted a personal, non-exclusive, 
non-transferable license to use such Software under the terms stated 
herein and in any case only with a single receiver or single computer. 
3D-Office User’s Manualx



Terms and Conditions
You may not assign or transfer the Software or this license without 
the express written consent of TPS. This license is effective until 
terminated. You may terminate the license at any time by destroying 
the Software and Manual. TPS may terminate the license if you fail to 
comply with any of the Terms or Conditions. You agree to destroy the 
Software and manual upon termination of your use of the receiver. All 
ownership, copyright and other intellectual property rights in and to 
the Software belong to TPS. If these license terms are not acceptable, 
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software 
(collectively, the “Confidential Information”) are the confidential and 
proprietary information of TPS. You agree to treat TPS’ Confidential 
Information with a degree of care no less stringent that the degree of 
care you would use in safeguarding your own most valuable trade 
secrets. Nothing in this paragraph shall restrict you from disclosing 
Confidential Information to your employees as may be necessary or 
appropriate to operate or care for the receiver. Such employees must 
also keep the Confidentiality Information confidential. In the event you 
become legally compelled to disclose any of the Confidential 
Information, you shall give TPS immediate notice so that it may seek a 
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the 
TPS website (or any other website) or in any other advertisements or 
TPS literature or made by an employee or independent contractor of 
TPS modifies these Terms and Conditions (including the Software 
license, warranty and limitation of liability). 

SAFETY Improper use of the receiver can lead to injury to persons or 
property and/or malfunction of the product. The receiver should only 
be repaired by authorized TPS warranty service centers. Users should 
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be 
amended, modified, superseded, or canceled, at any time by TPS. The 
above Terms and Conditions will be governed by, and construed in 
accordance with, the laws of the State of California, without reference 
to conflict of laws.
P/N 7010-0684 xi
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Manual Conventions
This manual uses the following conventions:

Example Description

File�Exit Click the File menu and click Exit.

Enter Click the button labeled Enter.

Topo Indicates the name of a dialog box or screen.

Notes Indicates a field on a dialog box or screen, or a tab 
within a dialog box or screen.

     

NOTE

Further information to note about the configuration, 
maintenance, or setup of a system.

TIP

Supplementary information that can help you 
configure, maintain, or set up a system.

NOTICE

Supplementary information that can have an affect 
on system operation, system performance, 
measurements, or personal safety.

CAUTION

Notification that an action has the potential to 
adversely affect system operation, system 
performance, data integrity, or personal health.

WARNING

Notification that an action will result in system 
damage, loss of data, loss of warranty, or personal 
injury.
3D-Office User’s Manualxii



What’s New
What’s New with 
3D-Office

The following list briefly describes new features and functions for the 
latest version of 3D-Office. 

Projection, Datum, and Geoid 
Support

• A number of projections and 
geoids are included with the 
installation.
See “Using Coordinate System 
Data” on page 9-13 for details.

• Custom projections and datums 
are supported via a 3D Project 
or 3D Control file.
See “Creating a Custom 
Projection or Datum” on 
page 9-14 for details. 

mmGPS Transmitter Support

• If a control point file included 
mmGPS transmitter 
information, this data can 
viewed.

•  If the computer and mmGPS 
transmitter are connected, 
firmware and adjustment data 
can be uploaded. 
See “Viewing and Adding 
mmGPS Transmitter 
Information” on page 9-20 for 
details.
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What’s New with 3D-Office
Template Placement Function 
Moved

For alignments, the template 
placement function is now 
included as a tab on the Road 
templates dialog box. 

Alignment Profile

A profile of the alignment can be 
viewed.
See “Viewing a Profile of the 
Alignment” on page 6-36 for 
details. 

Alignment Elements Import
In a 3D Project file, horizontal 
centerlines, vertical profiles, and 
x-sections can be imported from 
various file formats.
See “Importing Alignment 
Features” on page 6-5 for details. 
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What’s New with 3D-Office
Surface Parameters

For TIN, Alignment, Plane and 
Grid surfaces, parameters are 
located/have been relocated on 
the corresponding surfaces 
dialog box. 

From here, the surface name, 
layer, and visibility can be 
edited. The surface’s properties 
can be viewed or edited.

See one of the following sections  
for details. 

• “Viewing and Editing TIN 
Surfaces” on page 5-10

• “Viewing and Editing 
Alignments” on page 6-12

• “Working with Plane Surfaces” 
on page 7-5

• “Viewing Grid Information” on 
page 8-6

Grid Surface Support
Grid surfaces are now supported, 
and include the following 
functions:

• View, edit, copy, delete grids

• Create a grid

• Load grid data from a TIN 
surface

• Import/export grids

• View machine pass information

See Chapter 8 for details. 
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What’s New with 3D-Office
Update Authorization Codes

Occasionally, authorization 
codes can be purchased to 
upgrade or update a current copy 
of 3D-Office.
See “About 3D-Office” on 
page 1-21 for details. 
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Chapter 1
Introduction

Welcome to 3D-Office™, Topcon’s fully featured 3DMC software for 
machine control applications.

With 3D-Office, you can create, edit, import/export, design, and 
prepare files for any jobsite. Many of these files can be exported to 
the System Five-3D control box and Pocket-3D for immediate use in 
the field. 3D-Office imports files from the System Five-3D control 
box and Pocket-3D for office evaluation.

Installing 3D-Office
3D-Office comes on a CD to install on a computer. Table 1-1 lists the 
system requirements needed to properly use this software on a 
computer; optional accessories include CF card access to transfer files 
between the computer and System Five-3D control box. 

1. Insert the 3DMC Software CD into the CD-ROM drive of the 
computer.

2. Navigate to the CD-ROM drive’s folder and double-click the 
3D-Office folder to open it.

3. Double-click the Setup.exe icon (Figure 1-1) to begin the 
installation process. 

Figure 1-1. 3D-Office Setup.exe Icon

Table 1-1. 3D-Office System Requirements

• Microsoft® Windows 98/NT/
2000/XP

• 128MB of RAM

• 2MB of available hard-disk 
space (3MB recommended)

• CD-ROM drive
P/N 7010-0684 1-1



Introduction
4. Select a new destination folder or keep the default folder in which 
to install 3D-Office, and click Next (Figure 1-2). 

5. After reading the License Agreement, click “I accept...” and click 
Next. The installation process begins (Figure 1-2). 

Figure 1-2. Install 3D-Office

6. Click Finish to exit the installation wizard. The wizard also 
creates a shortcut to 3D-Office (Figure 1-3), placing it on the 
computer’s Desktop. 

Figure 1-3. 3D-Office Shortcut
3D-Office User’s Manual1-2



Uninstalling 3D-Office
Uninstalling 3D-Office
1. Navigate to the computer’s add/remove programs dialog box 

(click the Start button�Settings�Control Panel�Add or 
Remove Programs) and remove the Topcon 3D-Office program.

2. Click Yes at the confirmation (Figure 1-4).

Figure 1-4. Remove 3D-Office?

The Setup Status dialog box briefly displays, showing the 
uninstall progress.

3. Click OK to acknowledge the removal of 3D-Office (Figure 1-5).

Figure 1-5. 3D-Office Successfully Removed
P/N 7010-0684 1-3



Introduction
Starting 3D-Office
To start 3D-Office, click one of the following:

• Start�Programs�Topcon�3D-Office 

• Topcon 3D-Office shortcut 

Upon initial startup, 3D-Office requires authorization codes to start 
(Figure 1-6). Record the device identification number and contact 
your Topcon Dealer with the following information to receive 
authorization codes: 

Once you receive the authorization codes, enter them and click OK to 
open 3D-Office (Figure 1-6). When opening for the first time, a new 
project file displays. See “File Operations” on page 1-16 for details 
on creating, opening, and saving projects. 

Figure 1-6. Enter Access Code

Once entered, the authorization codes can be located and changed on 
the About 3D-Office screen. See “About 3D-Office” on page 1-21 for 
more details on viewing/changing authorization codes. 

• Device identification

• Company name

• Contact name

• Company address

• Contact phone number

• Contact email address

• Software Type (3D-Office)
3D-Office User’s Manual1-4



Getting Acquainted
Getting Acquainted
This section introduces the various menus, buttons, and windows used 
for viewing, managing, and editing project files.

Main Screen
The 3D-Office main screen (Figure 1-7) has the following 
components:

• Title bar – displays the name of the file

• Menu bar – contains drop-down menus for the various functions, 
and depends on type of file being displayed

• Toolbar – contains shortcut buttons to frequently used functions

• System buttons – minimizes, maximizes, and closes windows and 
dialog boxes

• Status bar – displays informative messages about the program’s 
status, as well as cursor/selection-tool coordinates 

• Plan View – shows a graphical representation of the data available 
in the current file 

Figure 1-7. 3D-Office Main Screen

Menu Bar
Tool Bar

Plan View

Status Bar

Title Bar
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Introduction
Menu Bar
Depending on the type of file open in 3D-Office, the menu bar 
displays different menus. Figure  displays the menu bar for 3D 
Project files (*.tp3). 

Menu Bar for Project FilesTable 1-2 lists the menu bar for other file types. 
Table 1-2. Types of Menus

File Type Menu Bar

3D Office file 
(*.tp3)

See Figure  above.

Control file 
(*.gc3)

TIN surface 
(*.tn3)

Alignment 
(*.rd3)

Points
(*.pt3)

Linework 
(*.ln3)

Plane surface 
(*.pl3)

Cut/fill plot 
(*.cf3)

Grid surface 
(*.gd3)
3D-Office User’s Manual1-6



Getting Acquainted
Table 1-3 describes the functions available in each menu. Some menu 
options depend on the file type open. 

Table 1-3. 3D-Office Menu Options

Menu Functions

File menu Available for all file types, in general the File 
menu provides the following functions:

• opens, saves, and closes a 3D-Office file

• opens a file from a Pocket-3D controller or 
another program’s file type

• closes the active file

• prints the contents of the current plan view

• defines printing variables

• provides fast access to recently opened files

• exits and closes 3D-Office 

Edit menu Available for all file types, in general the Edit 
menu provides the following functions:

• allows a redo or undo of the last operation

• cuts, copies, or pastes information

• inverts selected/un-selected data in TIN surface 
files 

View menu 

In 3D simulation views, the 
View menu has specific 
functions for controlling the 
simulation. See “3D-view and 
Profile View Menu Bars” on 
page 1-13 for details.

Available for all file types, in general the View 
menu provides the following functions:

• zooms in by 200% and zooms out by 50% on the 
display screen

• zooms to a part of the design area indicated with 
a drawn window

• displays the previous view magnification

• displays the entire extents of the design area

• sets the selection cursor to Select or Pan mode

• selects points and lines or triangles for some file 
types

• sets the view status for the Toolbar, Scale bar, 
and Status bar

• sets unit options for some file types
P/N 7010-0684 1-7
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Project menu Available for 3D Project (*.tp3), the Project menu 
provides the following functions. For Control 
(*.gc3) files, only the “Control points” menu 
option is available.

• sets and manages layer properties

• displays control point and GPS localization 
information

• imports and exports control points

• calculates map-projection coordinates

• defines a custom projection

• sets unit options for Project files 

Points menu Available for 3D Project (*.tp3) and Points (*.pt3) 
files, the Points menu provides the following:

• sets layer properties

• adds, edits, and deletes points

• displays the point list

• imports and exports control points

• transforms coordinates

• sets unit options for Project files 

Linework menu Available for 3D Project (*.tp3) and Linework files 
(*.ln3) files, the Linework menu provides the 
following functions. For Linework (*.ln3) files, 
this menu also views and edits layers.

• creates a new polyline

• drapes selected polyline entities to the TIN

• deletes selected polylines

• converts polylines to a new alignment

• imports linework files

• exports selected linework 

Table 1-3. 3D-Office Menu Options (Continued)

Menu Functions
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TIN menu Available for 3D Project (*.tp3) and TIN surface 
(*.tn3) files, the TIN menu provides the following 
functions:

• displays TIN surface information

• generates new TIN surfaces

• deletes triangles

• transforms the current TIN surface

• consolidates duplicate TIN points

• displays a 3D representation of the TIN surface

• displays a profile through the TIN surface

• imports and exports TIN surfaces 

• compares the current TIN surface with another 
surface

• sets TIN options 

Alignment menu Available for 3D Project (*.tp3) and Alignment 
(*.rd3) files, the Alignment menu provides the 
following functions. Only some menu items are 
available for *.rd3 files.

• displays alignment information

• defines horizontal elements and vertical curves

• creates, edits, and places templates

• reverses alignment stationing

• generates a TIN surface from alignment 
information

• displays a 3D representation of the alignment

• displays a profile of the alignment surface

• imports alignment information, horizontal 
centerlines, vertical profiles, and cross-sections

• exports alignment information

• sets alignment options

Table 1-3. 3D-Office Menu Options (Continued)

Menu Functions
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Plane menu Available for 3D Project (*.tp3) and Plane surface 
(*.pl3) files, the Plane menu provides the 
following functions:

• displays plane information

• sets plane parameters

• calculates new plane surfaces

• defines plane boundaries

• imports and exports plane surfaces

• compares a plane surface with another surface

• sets plane options 

Grid menu Available for 3D Project (*.tp3) and Grid surface 
(*.gd3) files, the Grid menu provides the following 
functions:

• displays grid surface information

• creates a new grid

• removes all grid data

• loads a current grid surface

• imports and exports a grid surface

• sets grid surface options.

Equipment menu Available for 3D Project (*.tp3) files, the 
Equipment menu provides the following functions:

• creates or edits machine setup files

• imports a machine setup from Pocket-3D

• exports a machine setup to Pocket-3D 

Tools menu Available for 3D Project (*.tp3) files, the Tools 
menu provides a tool to measure a distance or area 
in the plan view using the selection tool.

Table 1-3. 3D-Office Menu Options (Continued)

Menu Functions
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Standard Toolbar
The standard toolbar for 3D-Office (Figure 1-8) contains buttons for 
frequently used functions. 

Figure 1-8. 3D-Office Toolbar

Upon start-up, the toolbar displays beneath the menu bar.

• To display or hide the Toolbar, click View�Toolbar.

• To move the Toolbar, click and hold the “grab bar” on the left of 
the Toolbar, then drag the Toolbar to a new location and release 
the mouse button.

Table 1-4 describes the various buttons on the Toolbar. 

Window menu Available for all file types, the Window menu 
provides the following functions:

• opens the current file in a new window; any 
changes made in the new window are made in 
all windows of the same file

• arranges open files in cascade (stacked) or tile 
(adjacent) views and arranges icons

• lists all open files; the active file is marked with 
a check mark

Help menu Available for all file types, the Help menu opens 
on-line help topics and gives 3D-Office version 
and copyright date information.

Table 1-4. Standard Toolbar Button Functions

Button Description Button Description

New – Opens a new 
Project file window.

Zoom Out – Zooms out from 
the map by 50%.

Open – Opens a project. Zoom In – Zooms in on the 
map by 200%.

Table 1-3. 3D-Office Menu Options (Continued)

Menu Functions
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Save – Saves files to the 
current folder.

Zoom rectangle – Zooms to a 
rectangular area drawn in the 
Plan View.

Cut – Removes the 
selected information from 
the page or window, 
placing it on the 
Windows® clipboard.

Zoom previous – Displays the 
last magnification of the Plan 
View.

Copy – Copies selected 
information from the page 
or window, placing it on 
the Windows clipboard.

Zoom extents – Displays the 
entire design area.

Paste – Places selected 
information from the 
Windows clipboard to the 
current cursor position.

Pan – Changes the cursor to a 
“hand” with which to “grab” 
and move the map.

Print – Prints the Plan 
View.

Select – Changes the cursor to 
a crosshairs with which to 
click and select individual 
entities, or to click and drag 
over an area, creating a 
rectangle that selects enclosed 
entities.

Print preview – Displays 
how the Plan View will 
look when printed.

Poly-cursor – Changes the 
cursor to a crosshairs with 
which to draw a polygon 
around the entities to select.

About – Displays the 
About 3D-Office dialog 
box.

Information – Displays a text 
editor window containing 
information about the selected 
entities.

Table 1-4. Standard Toolbar Button Functions (Continued)

Button Description Button Description
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3D-view and Profile View Menu Bars
The 3D-view and Profile view menu bars for 3D-Office (Figure 1-9) 
include menus for controlling the view and the machine. The 
available menus depend on the type of view selected. 

Figure 1-9. 3D-view and Profile View Menu Bars

The menu bar for solid model simulations (TIN and alignment) 
has the following menu selections:

• File and Edit menus – have standard menu selections

• View menu – zooms in and out, selects topography information to 
display, selects the view in relation to the cab, applies grid and 
contour interval options

• Theme menu – changes the look of the “ground” in the simulation

• Machine menu – changes the machine displayed in the simulation

• Motion menu – plays log files, follows the road alignment during 
movement, monitors machine movement during real time

• Window and Help menus – have standard menu selections

The menu bar for Profile views has only the View menu selection 
for zooming in/out, using the pan or select pointer, and exaggerating/
decreasing the vertical view.

The menu bar for basic wireframe simulations (alignment) has the 
following menu selections:

• File and Edit menus – have standard menu selections

• View menu – zooms in/out, rotates the view left/right, decreases/
increases the viewing angle, provides machine image controls

• Alignment menu – has plan, profile, and 3D simulation view 
options

• Window and Help menus – have standard menu selections

Solid Model 3D Simulation Menu Bar

Wireframe 3D Simulation Menu BarProfile Menu Bar
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3D-view and Profile View Toolbars
The 3D-view toolbars for 3D-Office (Figure 1-10) includes buttons 
for controlling the view and machine. The available buttons depend 
on the type of 3D simulation, either solid model or wireframe. 

Figure 1-10. 3D-view Toolbars

Upon start-up, the toolbar displays beneath the menu bar.

• To display or hide the Toolbar, click View�Toolbar. 

• To move the Toolbar, click and hold the “grab bar” on the left of 
the Toolbar, then drag the Toolbar to a new location and release 
the mouse button.

Table 1-5 describes the various buttons on the 3D-view toolbars. 
Table 1-5. 3D-View Toolbar Button Functions

Button Description Button Description

Zoom In – zooms in on 
the 3D-view by 200%

Zoom Out – zooms out on 
the 3D-view by 50%

Solid Model Simulation Wireframe Simulation

Rewind – during logfile 
playback, rewinds the 
logfile

Slow down – slows down the 
movement of the machine

Fast forward – during 
logfile playback, 
speeds up the logfile

Speed up – starts and speeds 
up the movement of the 
machine

Play – during logfile 
playback, plays the 
logfile

Rotate view left 

Wireframe 3D Simulation Toolbar

Solid Model 3D Simulation Toolbar

Profile View Toolbar
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Pause – during logfile 
playback, pauses the 
logfile

Rotate view right 

Stop – stops the logfile 
playback 

Lowers the viewing angle 

Record – during real-
time monitoring, 
creates a logfile for the 
machine 

Raises the viewing angle 

Stop – in a wireframe 
simulation, stops the 
movement of the machine

Profile View

Pan – changes the 
cursor to a “hand” with 
which to “grab” and 
move the map

Exaggerates the vertical 
scale

Select – at the location 
of the crosshairs, Point, 
TIN, and Grade 
information display in 
a tip box.

Decreases the vertical scale

Snap to Station – 
rotates the profile line 
perpendicular to the 
center line, positioning 
it up the alignment

Rewind – during logfile 
playback, rewinds the logfile

Fast forward – during 
logfile playback, 
speeds up the logfile

Play – during logfile 
playback, plays the logfile

Pause – during logfile 
playback, pauses the 
logfile

Stop – stops the logfile 
playback 

Table 1-5. 3D-View Toolbar Button Functions (Continued)

Button Description Button Description
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File Operations
From the File menu, you can create, open, and save project files. You 
can also preview and print the display window, as well as enter title 
block information for any printed material.

The following sections describe opening and saving files, printing the 
display, and using the Print Setup feature.

Opening a File
3D-Office opens the following types of files:

By default, these files are saved to the last selected folder on the 
computer’s hard drive. However, files can be saved to and opened 
from any selected folder.

1. To open a file, do one of the following:

• click File�Open 

• click File then a recently opened file 

• click the Open button on the toolbar 

• press Ctrl+O 

2. On the Open dialog box, navigate to the location of the file, select 
the file type, select the desired file, and click Open (Figure 1-11). 

• 3D Project (*.tp3)

• Control file (*.gc3)

• TIN surface (*.tn3)

• Alignment (*.rd3)

• Linework (*.ln3)

• Points file (*.pt3)

• Plane surface (*.pl3)

• Cut/fill plot (*.cf3)

• Grid surface (*.gd3)
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Figure 1-11. Select File to Open

Saving a File
To save a file, do one of the following:

• Click File�Save 

• click the Save button on the toolbar 

• Press Ctrl+S 

When closing a file or closing 3D-Office after making changes to the 
current file, a Save changes confirmation displays. Click Yes, to save 
the changes and complete the operation (Figure 1-12). 

Figure 1-12. Save Changes
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To save the file under a different name or to a different location, 

click File�Save As. Navigate to the location in which to save the 
file, enter a name for the file, then click Save (Figure 1-13). 

Figure 1-13. Save File with a Different Name or in Another Location

Printing the Display

To print the Plan View, do one of the following: 

• click File�Print 

• click the Print button on the toolbar

• press Ctrl+P 

The current view prints, along with a title block (see “Print Setup” on 
page 1-20 for setting title block information).

TIP

Save the file as a variant of the original file to keep 
a backup copy or to track progress.

TIP

Before printing, view the display using Print 
Preview (see “Print Preview” on page 1-19 for 
details).
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File Operations
Print Preview

Use the Print Preview function to see how printed information will 
look on paper. Use this preview to check orientation, font size, etc. 

To view the print preview, click File�Print Preview or click the 
Print Preview button on the toolbar. 

The print preview dialog box displays the information that will be 
printed (Figure 1-14). 

Figure 1-14. Print Preview of the Plan View

TIP

Depending on the parameters previously set in the 
Print dialog box, the Print Preview will be in either 
portrait or landscape orientation.
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Print Setup

The Print Setup feature sets title block information and the size for 
text and map fonts. The title block information applied here is a 
global field and will be applied to all printed information.

Click File�Print Setup to change title block information printed 
with display views. 

Use the Print setup dialog box (Figure 1-15) to set the following:

• Company name – enter owner/user information to include in the 
title block

• Comment – enter desired information to include in the Comment 
area of the title block, such as the jobsite or location

• Text font – sets the text size in reports and title blocks

• Map font – sets the text size for entities viewed in the plan view, 
such as point names, coordinates, etc. 

Figure 1-15. Print Setup
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About 3D-Office
The About 3D-Office dialog box (Help�About 3D-Office) contains 
the following information:

• Software version and copyright date

• Device identification number

• Registered user

• Authorization codes 

Figure 1-16. About 3D-Office

Occasionally, upgraded or different functionality may required 
different authorization codes to become active.

1. Contact your Topcon Dealer with the following information to 
receive authorization codes: 

2. Click Help�About 3D-Office and enter the new codes.

3. Close and re-open 3D-Office to activate the updated codes.

• Device identification

• Company name

• Contact name

• Company address

• Contact phone number

• Contact email address

• Software Type (3D-Office)
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Notes:
3D-Office User’s Manual1-22



Chapter 2
Working in 3D Project 
Files

3D Project files provide a way to incorporate the various individual 
components of a jobsite into a single, cohesive file. Much of the 
functionality available in 3D Project files is the same as in other 
respective file types. However, 3D Project files provide certain 
features useful to working with multiple sets of different information 
and 3D Project specific functions, including the following:

• selecting and managing layers

• calculating map-projection coordinates

• working with polylines

• creating, managing, and transforming TIN surfaces

• creating and managing plane surfaces

• creating machine configuration files

• measuring a distance or area

• setting units for the 3D Project

The following sections provide the procedures on functions specific 
to 3D Project files, as well as some features useful for working with 
multiple file types. When 3D-Office first opens, an empty 3D Project 
displays.

• To create a new 3D Project file, click File�New.

• To open a current 3D Project file, click File�Open. Navigate to 
the location of the file, select a *.tp3 file, and click Open. 

For working with data sets in a 3D Project file or with individual file 
types, see chapters 3 through 9.
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Creating Custom Import/Export 
Formats for Text Files
Import/export formats for text files provide the information needed to 
identify specific elements so that the import/export process runs as 
intended. Text files (*.txt) provide a simple format for exchanging 
point information between software and platforms. Import/export 
formats are independent of project files and can be created or 
accessed when importing/exporting text files.

1. Navigate to the Select custom format dialog box and click New 
format (Figure 2-1). For example, click Project�Export 
control points�To text file. 

2. On the Custom format definition dialog box, type a name for the 
new format and an extension of the file, then click Add on the 
Line items tab (Figure 2-1). 

Figure 2-1. Create New Format

3. Select a line item Type and enter the desired parameters for the 
new format, then click OK. The available parameters depend on 
the type of line item selected (Figure 2-2 on page 2-3). 

1

2
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4. Repeat step 3 for each line item to add the desired number of line 
items (Figure 2-2). 

Figure 2-2. Add Line Items to Format

5. Click Import rules and click Add. Select the desired Rule and 
enter the applicable Number of lines to skip or lines with a certain 
Prefix to skip. Click OK (Figure 2-3). 

Figure 2-3. Add Import Rules

6. Repeat step 5 for each import rule.

5a

5b
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7. Click Export rules and click Add. Select the desired Rule and 
type a number to start at for points with no number. Click OK 
(Figure 2-4). 

Figure 2-4. Enter Export Rules

8. Repeat step 7 for each export rule.

9. When finished adding the desired Line items, Import rules and 
Export rules, click OK to save the new format (Figure 2-5). 

Figure 2-5. Save New Format

The newly created format can be used for subsequent import/export 
operations.

7a

7b
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Managing Layers
3D Project files may consist of imported data sets, such as points, 
linework, alignments, etc., as well as any layers associated with the 
data file. Each 3D Project layer is identified with a name and color.

To view, add, or edit layers, click Project�Layer selection & 
management. The View layers dialog box displays each layer in the 
3D Project file (Figure 2-6).

• The enable/disable box next to each layer name indicates whether 
or not the layer’s contents display on the Plan View.

• See the following sections for details on adding a layer, deleting a 
layer, setting layer colors, or setting point labels.

• Show all enables all layers for display on the Plan View.

• Show none disables all layers from being displayed on the Plan 
View. 

Figure 2-6. View Linework Layers
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Adding Layers
Multiple layers are useful for distinguishing between the various land 
and project features.

1. On the View layers dialog box, click New layer. A new layer 
entry appears in the layer list. 

2. Type a name for the layer (Figure 2-7) and press Enter. 

Figure 2-7. Add New Layer to 3D Project

When added, the new layer is “empty” until entities are manually 
added or imported. Use the procedures below to edit a layer’s color or 
point attributes.

Setting a Layer’s Color
Setting a unique color to individual layers in a 3D Project file helps to 
quickly differentiate between layers.

1. On the View layers dialog box, click the desired layer, then click 
Set color.

2. Select a color from the Color dialog box and click OK 
(Figure 2-8 on page 2-7).

1

2
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The color of the layer’s name changes to the selected color and 
the layer’s information will appear in this color on the Plan View. 

Figure 2-8. Select Layer’s Color

3. To select a color not shown in the Basic colors grid, click Define 
Custom Colors. Define the custom color and click Add to 
Custom Colors.

Setting a Layer’s Point Labels
Displaying point labels can help to identify points in the plan view.

1. On the View layers dialog box, click the desired layer, then click 
Point labels.

2. Check the desired label settings for the layer (or for all layers) 
and click OK (Figure 2-9). 

Figure 2-9. Select Point Labeling Parameters for Layer
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Deleting Layers
Only delete a layer when the data it contains will never be needed 
again. If needed, save a backup copy of the file before deleting layers. 

1. On the View layers dialog box, click the desired layer, then click 
Delete.

2. Click OK at the confirmation.

Calculating Geodetic and Grid 
Coordinates
The coordinate calculator utility in 3D Project files calculates map 
projection (grid) coordinates if given geodetic coordinates, and vice 
versa. 3D-Office calculates coordinates either directly using known 
geodetic coordinates or inversely using a known grid system.

If applying a geoid model to the elevation computations, a geoid file 
(*.gff) must be available. A geoid file provides information about the 
separation between the purely geometric, ellipsoidal representation of 
the earth and the physical model of the earth that closely 
approximates mean sea level (the geoid). For example, use a geoid 
model to obtain approximate mean sea level heights from GPS 
measured ellipsoidal heights.

Direct Coordinate Calculation
This procedure calculates grid coordinates based on given geodetic 
coordinates.

1. Click Project�Utilities�Coordinate calculator.

2. Select the projection and the geoid (optional) to use in the 
calculation (Figure 2-10 on page 2-9). 

NOTICE Deleting a layer will also delete all of its contents.
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3. Click Geodetic->Grid to compute grid coordinates 
(Figure 2-10). 

Figure 2-10. Select Projection, Geoid, and Transformation

4. Enter either WGS or Local geodetic coordinate values. Click the 
desired radio button, then type the Latitude, Longitude, and 
ellipsoidal ht value in each entry box (Figure 2-11 on page 2-10).

• The input format for latitude and longitude is 
DDD.MMSSssss. Use negative values for West longitude and 
South latitude.

• Enter the ellipsoid height in the same unit currently set for 
distances in the project. 
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Figure 2-11. Enter Geodetic Coordinate Values and Geoid Height

5. Click Calc. 3D-Office calculates the corresponding geodetic 
coordinates (WGS or local datum) and the grid coordinates based 
on the selected projection (Figure 2-12). 

Figure 2-12. Coordinates Calculated

6. If desired, click Save to save the calculated grid coordinates as a 
text file.
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Inverse Coordinate Calculation
This procedure calculates geodetic coordinates based on given grid 
coordinate.

1. Click Project�Utilities�Coordinate calculator.

2. Select the projection and the geoid (optional) to use in the 
calculation (Figure 2-13). 

3. If the given coordinates are in a known grid system, click 
Grid->Geodetic to compute geodetic coordinates (Figure 2-13). 

Figure 2-13. Select Projection, Geoid, and Transformation

4. Enter the XY grid coordinates and the elevation (Figure 2-14 on 
page 2-12).

• If a geoid file has been specified, leave the Geoid height field 
blank; 3D-Office will enter the geoid height as determined 
from the geoid file.

• If a geoid model is unavailable, manually enter the geoid 
height. Leave this blank if you do not know the value.
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Figure 2-14. Enter Geodetic Coordinate Values and Geoid Height

5. Click Calc. 3D-Office calculates the geodetic coordinates and the 
geoid height (if applicable) (Figure 2-15). 

Figure 2-15. Coordinates Calculated

6. If desired, click Save to save the calculated geodetic coordinates 
as a text file.
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Creating a Custom Projection
If a desired projection is not available, a custom projection can be 
created.

1. Click Project�Utilities�Custom projection.

2. Enter a name for the projection and select the type of project 
(Figure 2-16). 

3. If needed, enter the following projection information, or keep the 
default values (Figure 2-16). 

• Central meridian

• Scale

• Latitude

• East and North

4. Enter a description for the region, any notes, and select a datum 
(Figure 2-16). To create a custom datum, see “Creating a Custom 
Datum” on page 2-14 for details. 

5. Click Ok to save the custom projection (Figure 2-16). 

Figure 2-16. Create Custom Projection
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Creating a Custom Datum
If a desired datum is not available, a custom datum can be created.

1. Click Project�Utilities�Custom projection.

2. Click the Datum browse button (Figure 2-17). 

3. Enter a name for the datum and the following information 
(Figure 2-17) and click Ok to save the datum:

• Name – enter a name for the datum 

• Ellipsoid – select the ellipsoid used to create the datum 

• DX, DY, DZ – enter the ellipsoid’s shift parameters 

• RX, RY, RZ – enter the ellipsoid’s angle rotation parameters 

• Scale – enter the scale to adjust the ellipsoid by

• Notes – type any desired notes 

Custom datums will be available in the Datum list on the Custom 
Projection Definition dialog box.

NOTE

These parameters (shifts, rotations, and scale) 
specify a coordinate transformation from the new 
datum to the selected ellipsoid (WGS-84) using the 
following equation:

X
Y
Z WGS 84–

DX
DY
DZ

1 Scale 10⋅ 6–
+( )

1 RZ RY–

RZ– 1 RX
RY RX– 1

X
Y
Z new datum–

⋅ ⋅+=
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Figure 2-17. Create Custom Datum

Setting Project Units
The Project options dialog box sets the type of units to use for various 
quantities used in a 3D Project. When importing data contained in 
ASCII text, 3D-Office considers the data to be in the same units as 
that assigned to the project. To view or set the units for 3D Projects, 
click View�Options. 

On the Units tab, select the following information and click OK to 
apply the options to the file (Figure 2-18 on page 2-16):

• Select the linear unit to use for distances and coordinates, either 
Meters, US Survey feet, International feet, or Feet+Inches.

If using Feet+Inches, all values will show as 1'11''1/2 where 12 
inches equal 1 foot and any value smaller than an inch will show 
as a fraction of an inch.

• Select the decimal places to use for numbers with fractions of a 
measurement, from 0 to 4 decimal places. 

• Select the angle unit to use, either DD°MM'SS'', NDD°MM'SS''E, 
Gons, or DD.DDDD°.

2 3
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• Select the grade format to use, either Percent (%), Run : Rise, or 
Rise : Run

• Select the area unit to use, either Square meters, Square feet, 
Acres, or Hectares.

• Select the volume unit to use, either Cubic meters or Cubic yards.

• Select the coordinate ordering to be displayed in 3D-Office, 
either North-East-Elev, East-North-Elev, or X-Y-Z. 

• Select the stationing format to use, either 100.000, 1+00.000, or 
10+0.00. 

Figure 2-18. Set Project Options
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Machine Equipment Files
From a 3D Project file, 3D-Office can create, edit, import, and export 
machine equipment files (*.mb3) for use in the System Five-3D 
control box or in Pocket-3D.

The Machine Equipment File provides vital information about the 
type of machine, the setup of the components on the machine, 
machine or component measurements, and radio configuration.

Creating and Editing Equipment Files
1. Click Equipment�New machine to create a new equipment 

file. Click Equipment�Edit machine setup to edit a current 
equipment file. 

2. Type a name for the new equipment file (Figure 2-19), or select a 
current equipment file, and click Open. 

Figure 2-19. Create New Equipment File

3. Select the following information and click Next (Figure 2-20 on 
page 2-18): 

• Configuration name – if needed, type a new name for the 
equipment configuration

• Machine type – the type of machine to be used in the 
configuration 

• Sensor – the type of sensor on the machine 

• Location – the location of the sensor on the machine
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• Units – the units of measure used to specify the location of 
the sensor on the machine 

Figure 2-20. Equipment Configuration Type

4. Enter the measurements as described and illustrated on the screen 
(Figure 2-21), and click Next. The equipment measurements 
screen varies depending on the type of equipment and sensor 
selected. 

Figure 2-21. Enter Equipment and Sensor Measurements

NOTICE

Incorrect measurements or data entry errors directly 
affect grading accuracy. Take each measurement 
twice. and carefully review the entries before 
continuing.
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Machine Equipment Files
5. For GPS/mmGPS applications, enter the maximum GPS errors 
allowed for measuring points. Click Next. 

Figure 2-22. Enter GPS Point Measurement Precision Error Values

6. Specify the sensor configuration parameters (Figure 2-23), and 
click Next. The sensor options screen varies depending on the 
type of sensor selected.

7. Click Finish to complete the equipment configuration and save 
the file (Figure 2-23). 

Figure 2-23. Enter Sensor Options and Save Equipment Configuration
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Importing Equipment Files
Import equipment files from Pocket-3D to adapt an equipment type 
that was defined for another project.

1. Connect the Pocket-3D controller to the computer (see 
Appendix A for details). Run Pocket-3D on the controller.

2. With a 3D Project file open in 3D-Office, click Equipment� 
Import machine�From Pocket-3D controller.

3. On the Pocket-3D files dialog box, select the file to import and 
click Open (Figure 2-24). The file type is automatically selected. 

Figure 2-24. Select and Open Pocket-3D Equipment File

Exporting Equipment Files
Some activities, such as initializing a GPS+ system or starting an LPS 
station, require Pocket-3D to be loaded with an equipment file before 
proceeding. 3D-Office can export equipment files to Pocket-3D for 
use on the jobsite.

1. Connect the Pocket-3D controller to the computer (see 
Appendix A for details). Run Pocket-3D on the controller.

2. With a 3D Project file open in 3D-Office click Equipment� 
Export machine�To Pocket-3D controller.

3. Select the machine file to export and click Open (Figure 2-25 on 
page 2-21). 3D-Office connects with the Pocket-3D controller.
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Figure 2-25. Select Machine to Export

4. On the Pocket-3D files dialog box, enter a new file name or keep 
the default file name (Figure 2-26). The file type is automatically 
selected.

5. Click Save to export the selected equipment file to the Pocket-3D 
controller’s memory (Figure 2-26). 

Figure 2-26. Save File to Pocket-3D Controller
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Measuring a Distance or Area
The measuring tool computes distances between points and areas of 
polygons. For example, this tool can be used to determine the length 
along a route or to measure the area of a building pad.

1. With a 3D Project file open, click Tools�Measure distance/
area. A check mark displays next to the menu option.

The polygon cursor is automatically selected and a pop-up box 
displays running length and bearing.

2. Click at a point to begin the measurement. Move the polygon 
cursor to the next point and click. Continue in this manner until 
the desired distance or area has been delineated.

• When measuring a distance, the length of the drawn line 
drawn displays (Figure 2-27). 

Figure 2-27. Measure Distance

• When measuring an area click three or more points, then 
return the polygon cursor to the starting point to complete the 
polygon. The polygon perimeter length and its area display in 
the pop-up box (Figure 2-28 on page 2-23). 
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Measuring a Distance or Area
Figure 2-28. Measure Area

3. To quit this function, click Tools�Measure distance/area or 
click one of the selection tools, or press Esc.
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Notes:
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